
 

What is HTML? 

HTML or “Hyper Text Markup Language” refers to a system for communicating to a Web 
browser how the contents of a page will be displayed. HyperText is a concept that goes 
back to the mid-1940s when Vannevar Bush1 envisioned a system for linking together 
concepts within and among documents. A markup language includes text and information 
about how the text should be displayed. In HTML this extra information is communicated 
to the browser in the form of codes or “tags.” HTML tags, which do not appear in the 
displayed text, are delineated with brackets < >. 

This for example is the traditional tag for creating a line break: <br> 

Most HTML elements require both opening and closing tags, <tag> for opening and 
<tag/> for closing. For example the tags to make words italicized look like this: <i> italics 
</i>; or, in later versions of HTML, like this: <em> emphasis </em>. 

[Quick Tutorial side-bar] 

Take a look at HTML in action. Follow these steps: 

1. Open a Web browser such as Internet Explorer or Mozilla Firefox. 

2. Enter the following URL in the address bar: http://www.w3.org/  
This opens the World Wide Web consortiums home page. 

3. Now go to the View Menu and choose View Page Source  
 

This is what a complex html document looks like. Don’t be alarmed, however, we don’t 
have to write code like this to create Web pages. Thankfully, we have Web page editors 
that will do this work for us. Still, it’s a good idea to at least have a basic understanding of 
what HTML is and how it works. 

Scroll through the code for the W3 page. Jot down a few of the tags you see. For example: 
<div>, <li>, <p> and so on. 

To create a simple Web page, all you need is a text editor such as Note Pad on the 
Windows operating system (OS) or TextEdit on Mac OS. When saving your documents on 
a Mac, make sure to select “Make Plain Text” from the Format menu. You will also need a 
Web browser such as Internet Explorer, Mozilla Firefox, or Safari (Mac) to view your page. 

 

Tutorial: Creating your first Web page in HTML 

Introduction: Although this tutorial is designed to teach you how to make a simple Web 
page, in the process of learning this you will become familiar with a number of very 
important concepts that will be useful in other areas. 

                                                
1 As we may think, Bush, V. originally published July, 1945, viewed online (Nov. 8th 2006)  
http://www.ps.uni-sb.de/~duchier/pub/vbush/vbush.shtml 
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Completing this tutorial will help you meet the following objectives: 

• Learn basic HTML (HyperText Markup Language) and how it is used to create Web 
pages. 

• Learn how to set up a Web page folder 

• Learn how to add links to your Web page 

 

Just enough HTML… 

As stated above, HTML is the computer language of the Web. Don't worry though, it is a 
very simple computer language. HTML is the "code" that tells your Web browser 
application (program) how to display a Web page. 

Here are a few example tags: 

• <b> = bold [text will be bold] 

• <center> = center [text will be centered on the page] 

• <hr> = horizontal rule  [you will create a line across the page] 

 

Many HTML tags come in pairs. One tag "opens" and another "closes." For example, if 
you want just part of your text to be bold, you can use HTML tags to tell the browser when 
to start making text bold and when to stop. This is how you do it: <b> is the opening tab 
and </b> is the closing tag. 

Now let's try "coding" a little HTML ourselves. Follow these steps: 

(Note: If you are on a Macintosh computer, use TextEdit in place of NotePad. It can be 
found in the applications folder). 

1. Open Notepad: Point to the START menu, Point to PROGRAMS, Point to 
ACCESSORIES, Click on NotePad 

2. In NotePad type the following text:  

<html> 
<head> 
<title>My Web Page</title> 
</head> 

This top section is called the “head” and is where the Meta Data of your Web page is 
stored. This is information that is not displayed in the browser window. Though, the 
<title> element does display at the very top of the window showing the page .  

 

3. Now type the following: 
<body> 
Welcome to my Web page 
</body> 
</html> 
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You have just written a Web page! Really, it's true! ...I can prove it, but first you will have 
to save your document. 

Follow these steps to save your project as an html file: 
 

4. Go to the File menu and click Save As. 

5. In the Save As box, navigate to the desktop (you can click the desktop button on 
the left side). 

6. Create a new folder on the desktop, you can do this by clicking the yellow New 
Folder button at the top of the Save As box. Name your folder after yourself. For 
example I would call my folder: "timspage" [NOTE do not use capitals or spaces. 
This will be important later when you put your Web page online. Many Web 
servers don't like spaces and capitals.] Click Open or double-click the new folder to 
open it. You want to be sure to save your file there. 

7. Name your file “index.html” 

8. Click OK to save your file and close the Save As box. 

Note: As you proceed in learning to create a Web page, it's important to keep this folder 
in mind. Most Web sites you visit online are stored in a computer called a Web server that 
publishes the Web pages to the Internet. A Web server can store many Web sites. Each 
one is contained in a "directory" or folder. Now that you are in the process of creating 
your own Web page, it's important to keep all the files connected to that page in the same 
folder. This will not only help you keep track of your various files, it will also help ensure 
that the links and images in your page work properly. 

Now that you've saved your file you can check to see if your page is really a Web page by 
following these steps: 

1. Minimize your NotePad document to move it out of the way. You should now be 
able to see the desktop.  

2. Double click your new folder (in my case it would be called "timspage"). You 
should be able to see your file, “index.html” inside the folder.  

3. Double-click the file. If everything was done correctly, your file should open in a 
Web browser such as Internet Explorer. You will see a mostly blank page with the 
words, "Welcome to my Web page" at the top. 

Now you can quickly make changes in your HTML code and view them in your browser. 
Here's how: 

Let's add a new tag to your HTML code. Switch back to NotePad by clicking the box on 
the task bar at the bottom of the screen. Add this tag, <hr> , below the "Welcome to my 
Web page text". (You will have to place the cursor next to the text and hit ENTER to add a 
new line). The <hr> tag will put a line across the page.  

Your code should look like this: 
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<html> 
<head> 
<title>My Web Page</title> 
</head> 
<body> 
Welcome to my Web page 
<hr> 
</body> 
</html> 

In order to test this, all you have to do is choose Save from the File menu then switch to 
your Web browser. Once in your Web browser, click the Refresh button to see your 
changes. 

Here are a few more tags you can add to see the effect: 

• <center>use these tags to center text</center> 

• <b>use these tags to make text bold</b> 

• <i>use these tags to make text italic</i> 

If you would like to center the text “Welcome to my Web page” and make it bold, you can 
do so by using nested tags. Nested tags allow you to add more than one attribute to a 
particular element in a page. Here is an example:  

<center><b>Welcome to my Web page</b></center> 

The important thing to remember is that nested tags must follow the reverse order that 
they were introduced. (This is called LIFO or “Last In First Out”). In the example above 
the last attribute introduced is the bold <b> tag, which will be the first one you close </b> 
following the text that you want to be bold. You then proceed to close all tags in the same 
order. Examine the following example of a nested tag with more elements: 

<center><b><i><u>Welcome to my Web page</u></i></b></center> 

This line will be centered, bold, italic, and underlined. Notice that the close tags on the 
right of the text follow the reverse order of the tags on the left. 

The last step in this exercise is to add what is called a hyperlink or simply link. The tag 
you use to add a link looks like this: 

    <a href="http://google.com">Google</a> 

In the tag above the address in quotes is a standard Web URL, you must include the 
entire address. The text that appears after the URL (here it is "Google") will be the blue, 
underlined text on the page that you can click. 

Here is how the tag will appear in your code. 

<html> 
<head> 
<title>My Web Page</title> 
</head> 
<body> 
<center>Welcome to my Web page<center> 
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<hr> 
Here is my favorite search engine:  
<a href="http://google.com">Google</a> 
</body> 
</html> 

 

Add this code to your NotePad page, Save your changes, switch back to your browser and 
click the Refresh button. You should now see a link to Google on your page. You can 
click the link to test it. 

In this exercise you learned how to create a basic Web page using HTML code and how to 
set up your Web page folder.  

If you are interested, I encourage you to continue to learn more about HTML, but rest 
assured that you will not have to bother with coding your Web pages if you are not 
inclined to do so.  

 

Additional HTML resources 

Here are a few resources for learning more about HTML and Web page development. 

The Wikipedia online encyclopedia has excellent information about HTML and the Web 
and would be a good starting point to learn more about these technologies: 

http://en.wikipedia.org/wiki/HTML  

 

The World Wide Web Consortium (W3C) is an international organization dedicated to 
creating standards for Web design. There are a number of resources available on their 
Web site: 

http://www.w3.org/MarkUp/#tutorials  

 

HTML Dog is a commercial site with free tutorials. 

http://htmldog.com/guides/htmlbeginner/gettingstarted/  

 

Getting it online: 

You have created your first Web page and you have viewed it in your browser, but to 
really use Web pages, you need to put your pages online. To achieve this, you will need to 
have Web space where you can store Web pages and associated files, and you will need to 
have software that allows you to transfer your files from your computer to your Web 
space. 

Finding Web space: 

As a teacher the best place to start looking for Web space is probably your institution. 
Nearly all educational institutions now have Web servers that host their public Web sites 
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as well as spaces for faculty, staff and students. The best way to go about getting your own 
account is to contact the network administrator for your institution. 

If you don’t have access to an institutional account another option is to check your 
Internet service provider (ISP) to see if they provide Web space for clients. Most ISPs now 
offer a small amount of Web space with an account. Additionally, there are a number of 
online services that provide Web space and possible online tools for creating Web pages 
such as Yahoo Geocities (http://geocities.yahoo.com/) or Google Pages 
(http://www.googlepages.com). Finally, you can purchase your own Web space through a 
Web space provider. However, I would caution most people away from this option until 
you have become more proficient with these technologies. 

In the next tutorial we will begin using a program called Nvu that not only allows you to 
edit your Web pages visually as you would a word processing document, but also includes 
a built in FTP (File Transfer Protocol) function that you can use to upload your pages to 
your Web space. 
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